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What’s New 

 

1 New General Features

 

1.1 cncKad is Now an MDI Application 
MDI is an acronym for Multiple Document Interface.

This means that it possible to open as many files as needed in main cncKad window: 

You can switch between the windows using the ALT+Tab shortcut. 
In addition to that, you can switch between the open parts from the new Window Menu, as 
well as Tile, Cascade, etc:

There are also new features in File Menu, allowing you to Save/Close not just one window,
but all of the windows at the same time: 
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This feature is useful for instance when you work with nests and you want to edit some 
parts.
For example:
We added two circles to the part below, saved it and switched to a nest (open at the same
time) which includes this part.
We immediately receive a message saying that the parts in the nests were updated – and all 
this was done in just one cncKad window opened on our tray! 

 

1.2 Parametric Parts Library
cncKad now offers you a completely new and easy way of creating new parts.
You can create parametric parts like the one presented on the picture below directly from the 
New Part dialog: 
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The Part Library mechanism provides the capability to select, configure and create part 
geometries from a predefined Shapes' Library:

 

1.3 CAM Layers
A single cncKad part can now contain different processing definitions, CAM Layers,
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corresponding to one unique geometry. 
Each layer can contain its unique processing, and one part can be used to generate NC 
codes for different machines (Punch, Cutting, Combined etc.).
This means that you don't need to save the same part several times, each time with different 
processing definitions – whenever you update your part's geometry, the processing will be 
updated for all the layers.
To add processing definitions, select the CAM Layers option from CAM Menu, or click the 

 icon in the CAM Toolbar. This will open the dialog allowing you to create, edit and 
delete layers: 

This feature is useful when you have the same part nested at an angle of 

 

0° but also at

 

90°:

In the above example, in both Layers the horizontal Slitting is done with an 

 

RE 50 5 (in green) 
and the vertical with an 

 

RE 65 5 90 (in blue). 

 

1.4 User Data in File Preview 
When opening a part you can now see not only the part preview, but also  the User Data as 
well as part's Material and Thickness:
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1.5 Enhanced Checking for Part Destroying Punches 
The feature of checking whether a punch destroys the part has been extended to all 
punching types. 

 

1.6 AutoPunch, AutoCut and Cut Settings Machine Specific 
Auto Punch, Auto Cut and manual Cut Settings are now per machine. 
A workstation with several machines can have different settings for each.

 

1.7 Editing Multiple Bend Lines 
You are now able to edit several Bend Lines at the same time, setting the parameters for 
Angle, Text Size, etc. 

 

1.8 System Origin is Now Machine Specific 
The System Origin selection is specific for each machine and can be set in the default
Machine Settings dialog, on Machine tab:
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1.9 Context Sensitive Right-Click 
When you right-click in cncKad’s window you will be presented with Zoom Menu options, 
allowing you easier manipulation of the sheet: 

When you right-click next to an entity (entities) you will be presented with Delete Menu
options, Zoom options, as well as a few others: 
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1.10 Entity Highlighting
Anytime you now place the cursor next to an entity, the latter one will be highlighted, as
shown in the picture below: 

 

1.11Customizable Keyboard Shortcuts 
Activating this option from Settings Menu allows you to create your own shortcuts for
various cncKad functions, as well as changing the existing ones:
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1.12Open Files without Existing Tools 
Up until now when you opened a part and some special tool file didn't exist, cncKad would 
delete all the processing definitions.
Now it deletes only those punches processed with the missing tool, and loads the other
tooling definitions.

 

1.13Load and Replace Parts in a Nest 
You can now replace part of selected nest instances.

 

1.14Push Out Movement 
This feature of View Menu allows the user to see the push out movement and prevent 
unnecessary machine crashes: 

The push out movement will be displayed when you select the "Show Push Out 
Movement" menu item or when you select an entity on the drawing: 
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1.15 Bounding Box
This new feature of the Draw Menu allows you for drawing bounding rectangle of the part,
with the option of offsetting it from the boundaries of the box. 

Example:
Before:

 

After (with margin of 10): 
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1.16Break Lines into Segments 
Located in the Draw Menu, this function breaks selected lines into segments with the
following parameters:

A - Distance from edge 
B - Gap distance 
C - Internal break distance

See the following example:

 

1.17Find Bend Step 
This new feature of Draw Menu is useful in finding the number of bends and their 
corresponding angles, required to approximate an arc.
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After entering the desired length of each step, the actual step for the arc will be calculated.
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2 New Punch Features

 

2.1 AutoPunch Crunches Irregular Shapes and Notches
Now the AutoPunch option automatically crunches orthogonal, rectangular shapes and
notches. See the following example:
Part before crunch: 

And after being automatically processed: 

 

2.2 Maximal hit number for Crunch in AutoPunch 
Now in AutoPunch the user can define a maximum number of hits for crunch. In case when 
the amount of the hits in crunched entity (notch or whole) is bigger than the quantity entered in 
the dialog, the crunch will be replaced by slitting:



What’s New 

 

2.3 Free Hand Single Punch with Auto Snap 
Free Hand Single Punch can now be used with  Auto Snap option. This means that when the 
Auto Snap option is selected a punch is placed on one of the end points or the center point of 
the closest entity.

 

2.4 Sorting Per-Side in Tool Library 
You can now click on the Tool column in the Tool Library in two ways – according to tool 
length (first size parameter) and width (second size parameter): 
Sorted by tool length: Sorted by tool width: 
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2.5 New Tool Options 
There are new features for handling tools:

 

2.5.1 New Print Tools Option
There is now a new option in the Tools' Library, allowing you to print the current tab:

 

2.5.2 CR Tool with MJ 
From now on Corner Radius tools can be defined with MicroJoint edges.
In the Create Tool dialog you can check the MJ box and a MicroJoint edge will be added to 
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your tool: 

As you can see below, the CR tool with MicroJoint is denoted with "–" sign preceding the 
tool’s parameters: 

When used on a part we will get the following result: 
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2.5.3 Cluster Tools Support in AutoPunch
AutoPunch now checks the possibility of using defined cluster tools, and uses them 
whenever possible.

 

2.5.4 Set ToolN From Library
This new option of Used Tools dialog enables you to replace the ToolN parameter for all the 
used tools with the value from current tool library.
For example: for DFT with the following settings:

these changes were applied after the Set ToolN From Library button was pressed: 

 

2.5.5 Multi Radius Tools 
AutoPunch and Manual Punch support the option of crunching circles with multi-radius tools: 
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What’s New 

 

2.6 Linear Turret

 

In V9,  a Linear Turret can be defined:

And a Turret Setup as well: 
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Linear Turrets are useful for machines such as Buss-Bar, Coil, and even some standard 
machines such as Amada OCTO. 

 

2.7 Set start placement position for X 
On the Sheet tab in the Set Sheet and Clamps dialog a now the a user can choose the start 
position from left (from origin) or from right (from end): 
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3 New Laser Features 

 

3.1 Wire Joint for Common Cuts 
This new feature refers to Laser, Plasma, Flame and Water Jet cutting machines, allowing the 
user to define tool path breaks during common cuts. It is accessible from Common Cuts 
section of AutoCut tab in Auto Cut dialog:

 

3.2 MicroJoints in AutoCut 
You can automatically add MicroJoints when you use the AutoCut feature: 

 

3.3 Vaporize Sheet Before Cutting
On the Cutting Parameters tab in Set Sheet and Clamps dialog you will now find 
Vaporization features, allowing you for more efficient work.
You are now able to choose whether to vaporize the whole sheet, a cut or a pierce, before
processing the sheet with cutting.
In the past you could only set these options by adding vaporizing functions before the cut. 
Now you can define in one place both their sequence and the vaporizing area: 
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3.4 Marking Before Cutting
This option of Cutting Optimization tab in either the Set Sheet and Clamps or the Machine
Settings dialogs, allows you to execute Marking on the part or on the whole sheet: 

 

3.5 Freehand Entry Point for Cut 
You can now set the Entry Point of a cut to any location on your contour: 

You can use Snap None to position the Entry freehand, or any of the standard Snaps to 
position it automatically.

 

3.6 Reduced Feed Rate
The Cutting Technology Table contains a column of Reduced Feed Rate for each feed rate. 
This parameter is used for better accuracy of the job time estimation of the part. 
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3.7 Path Finder (Adjust Tool-Path) 
This automatic option calculates a path from one hole to another, trying to avoid passing 
through already cut holes. See the following examples before and after utilizing this function:

Before:

After:
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Before: After:
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4 New in Tube Cutting

 

4.1

 

3D Simulation for Intersections 
Tube Cutting has been 

 

significantly enhanced with 3D simulation of the f inished cuts.
After using Create Intersection to add cuts to your tube, you can now simulate these cuts in 

 

3D. After processing your intersections, select the

 

3D View option from the Tube menu: 

You will now see how your tube will look after cutting it: 
Flat view: 

 

3D View: 

 

4.2 Graphical Enhancement
The Create Intersection dialogs now show the intersection 

 

parameters in 3D, making adding 
cuts easier and more intuitive: 
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5 New in AutoNest

 

5.1 Automatic DXF to NC Solution 
It is now possible to load a nested DXF in AutoNest module and create NC for it, skipping 
the necessity of converting the parts into DFTs and processing them in cncKad.

 

5.2 Avoid Predefined Clamps Area 
This option of the AutoNest tab in the Workspace Settings dialog allows you to avoid 
predefined clamps area so that the automatic nesting will not place parts on clamps. 
This allows you to create nesting solutions without the necessity of Repositions. 

 

5.3 Full Support for Hole Filling
The Fill Holes and Fill Holes for All Subnests options now work both for Rectangular and 
True Shape nesting strategies:

 

5.4 Edit Part Common Cuts Parameters in AutoNest 
Now it is possible to Edit Part Common Cuts parameters. 
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6 New in CAD Link
The CAD Link module now has better support for exporting entire assemblies with a single 
button click, with better support for user customization. 
The CAD Link toolbar\menu now has a new option – cncKad Properties:

This opens a dialog where you can set your part’s material from cncKad’s Material Database 
(as before), but you now have new options:

 

6.1 cncKad File Path 
After you have exported your model to cncKad, the cncKad File Path shows you where your 
DFT file was saved. This is the file that will be updated when you use CAD Link’s Update
feature.
If you want to update a different file, simply Browse to it, or type the path you want. 

 

6.2 cncKad Settings
The cncKad Settings button opens a new dialog: 
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Here you can set various options that will determine where your exported cncKad part will be 
saved, under which name, and other options. 
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7 Import and Export

 

7.1 Import Dimensions from AutoCAD
You can now import parts with their dimensions from AutoCAD.
Supported dimension types are: linear, aligned, radius, diameter and angular.
Angular dimensions are only partly supported. 

 

7.2

 

AutoCAD2008 DWG Supported 

 

DWG files from AutoCAD2008 are now fully supported for import. 

 

7.3 Export to DXF/DWG Non Solid-white Entities 
AutoNest can now export non solid-white entities to DXF/DWG files. 

 

30



What’s New 

 

8 Feature Enhancements

 

8.1 New Option in Check for Duplicates
The Check for Duplicates option now applies to text as well. 

 

8.2 Changes for Check Process 
The Check Process algorithm now verifies whether each entity has been processed or not 
instead of examining the contour as a whole. 

 

8.3 Added Price Precision in Estimation
Now the Time Estimation Settings dialog is split into two tabs, allowing you to define the 
price estimations for your machine efficiently and precisely.
The first tab contains general pricing settings with a new Price Precision field: 

A second tab consists of Additional Time Constants:
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8.4 Changes in Sheet Transformation 
Now it is possible to set offsets for the transformation option "NONE".

Set CAMs to Current option gives you possibility of selecting either all punches placed on the 
sheet, or all punches made with same tool. 
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